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Chapitre 1. Introduction à KiCad



KiCad est un logiciel open-source destiné à la création de schémas
électroniques et de circuits imprimés. D’apparence monolithique, KiCad est
en réalité composé de plusieurs logiciels spécifiques qui coopèrent :
	Nom du programme	Description	Extension de fichier
	KiCad
	Gestion du projet
	*.pro

	Eeschema
	Édition de schématique (schémas et symboles des composants)
	*.sch, *.lib, *.net

	CvPcb
	Association composants / empreintes
	*.net, *.cmp

	Pcbnew
	Édition de circuits imprimés
	*.kicad_pcb

	GerbView
	Visualisation des Gerber
	Extensions gerber usuelles

	Bitmap2Component
	Conversion d’images bitmap en symboles ou empreintes
	*.lib, *.kicad_mod, *.kicad_wks

	PCB Calculator
	Calcul pour composants, largeurs de pistes, isolation électrique, code couleur, etc.
	Aucun

	Pl Editor
	Édition de cartouche
	*.kicad_wks



Note
La liste des extensions de fichier n’est pas complète et ne contient que les
fichiers caractéristiques de chaque application de la suite KiCad.

KiCad peut être considéré comme suffisamment abouti pour servir à la
conception et la maintenance de cartes électroniques complexes.
KiCad n’a aucune limitation de taille des circuits imprimés et peut
facilement gérer jusqu'à 32 couches de cuivre, jusqu'à 14 couches
techniques, et 4 couches auxiliaires.  KiCad peut créer tous les fichiers
nécessaires à la génération de cartes électroniques et notamment des
fichiers Gerber pour photo-traceurs, des fichiers de perçage, des fichiers
d’implantation des composants etc.
Étant open source (licence GPL), KiCad est l’outil idéal pour la création de
matériel électronique orienté open source.
Sur Internet, le site principal de KiCad est :
http://www.kicad-pcb.org/

1.1. Téléchargez et installez KiCad



KiCad fonctionne sous GNU/Linux, Apple OS X et Windows. Vous pouvez trouver
les instructions les plus à jour et des liens de téléchargement à :
http://www.kicad-pcb.org/download/
Important
KiCad stable releases occur periodically per the
KiCad
Stable Release Policy.  New features are continually being added to the
development branch.  If you would like to take advantage of these new
features and help out by testing them, please download the latest nightly
build package for your platform.  Nightly builds may introduce bugs but it
is the goal of the KiCad Development Team to keep the development branch as
usable as possible during new feature development.


1.2. Sous GNU/Linux



Constructions stables. Stable releases of KiCad can be found in most distibution’s package managers
as kicad and kicad-doc. If your distribution do not provide latest stable
version, please follow the instruction for unstable builds and select and
install the latest stable version.
Constructions instables. Les constructions dites instables sont construites à partir du code source
le plus récent. Elles peuvent parfois présenter des erreurs à l’origine de
corruption de fichiers, de mauvais fichiers gerbers, etc. mais sont le plus
souvent stables et possèdent les dernières fonctionnalités.
Sous Ubuntu, la façon la plus facile d’installer une version instable de
KiCad est de passer par les PPA et Aptitude. Tapez dans votre terminal
:
sudo add-apt-repository ppa:js-reynaud/ppa-kicad
sudo aptitude update && sudo aptitude safe-upgrade
sudo aptitude install kicad kicad-doc-en


Sous Fedora, la façon la plus facile d’installer une version instable de
KiCad  est de passer par copr. Pour installer KiCad en utilsant copr,
tapez ce qui suit dans copr :
sudo dnf copr enable mangelajo/kicad
sudo dnf install kicad


Vous pouvez cependant télécharger et installer une version pré-compilée de
KiCad ou bien télécharger le code source, le compiler et installer KiCad.

1.3. Sous Apple OS X



Constructions stables. Stable builds of KiCad for OS X can be found at:
http://downloads.kicad-pcb.org/osx/stable/
Constructions instables. Les constructions dites instables sont construites à partir du code source
le plus récent. Elles peuvent parfois présenter des erreurs à l’origine de
corruption de fichiers, de mauvais fichiers gerbers, etc. mais sont le plus
souvent stables et possèdent les dernières fonctionnalités.
Des constructions instables peuvent être trouvées à :
http://downloads.kicad-pcb.org/osx/

1.4. Sous Windows



Constructions stables. Stable builds of KiCad for Windows can be found at:
http://downloads.kicad-pcb.org/windows/stable/
Constructions instables. Les constructions dites instables sont construites à partir du code source
le plus récent. Elles peuvent parfois présenter des erreurs à l’origine de
corruption de fichiers, de mauvais fichiers gerbers, etc. mais sont le plus
souvent stables et possèdent les dernières fonctionnalités.
Vous pouvez trouver des constructions instables pour Windows à :
http://downloads.kicad-pcb.org/windows/

1.5. Assistance



Si vous avez des idées, des remarques, des questions ou si vous avez besoin
d’aide :
	
Visitez le Forum

	
Rejoignez le Canal IRC #kicad
  sur Freenode

	
Watch Tutorials




Chapitre 2. Echanges de données dans KiCad



En dépit des ressemblances avec d’autres logiciels de conception de circuits
imprimés (PCB), KiCad se caractérise par une organisation dans laquelle
symboles et empreintes des composants sont des entités disjointes. Cela fait
fréquemment l’objet de discussions sur les forums internet.

2.1. Aperçu des échanges de données dans KiCad



Le travail avec KiCad s’organise en deux tâches principales : la réalisation
du schéma et celle du typon. Une librairie de composants et une librairie
d’empreintes sont nécessaires pour ces deux tâches. KiCad en fournit de
nombreuses. Si celles-ci devaient ne pas vous suffir, KiCad dispose
également d’outils pour créer de nouveaux composants ou de nouvelles
empreintes.
La figure ci-dessous représente comment le travail dans KiCad est
organisé. Elle explique quelles sont les étapes à suivre et dans quel
ordre. Les icônes correspondant aux étapes sont représentées quand c’est
possible.
[image: Organisation du travail dans KiCad]
Pour plus d’informations sur la façon de créer un composant (symbole), voir
la section de ce document intitulée
Créer un composant (symbole) avec KiCad. Et pour plus d’informations sur la façon de créer une nouvelle
empreinte, voir la section intitulée Créer une empreinte.
Sur le site suivant :
http://kicad.rohrbacher.net/quicklib.php
Vous trouverez un exemple d’un outil permettant de créer rapidement une
librairie de symboles KiCad. Pour plus d’informations à propos de quicklib,
voir la section de ce document intitulée
Créer un composant (symbole) avec quicklib.

2.2. Annotations et rétro-annotations



Une fois qu’un schéma est terminé, l'étape suivante consiste à passer au
typon en suivant les étapes décrites dans le diagramme ci-dessus. Une fois
le typon commencé ou terminé, si des modifications sont nécessaires (ajout /
suppression / remplacement de composants, de fils …), elles sont réalisées
par des annotations (Forward Annotation) et rétro-annotations (Backward
Annotation) pour conserver les correspondances entre schéma et typon.
La rétro-annotation (Backward Annotation) consiste à renvoyer un changement
depuis le routage vers le schéma. Cette fonctionnalité n’est pas jugée utile
par tous.
L’annotation (Forward Annotation) consiste à envoyer un changement du schéma
vers le routage. C’est une fonctionnalité essentielle pour ne pas avoir à
refaire entièrement le routage de votre carte à chaque fois que vous
souhaitez modifier votre schéma. L’annotation (Forward Annotation) est
décrite dans la section intitulée Forward Annotation.

Chapitre 3. Dessiner des schémas électroniques



Dans cette section, nous allons apprendre comment dessiner un schéma
électronique avec KiCad.

3.1. Utiliser Eeschema



	
Sous Windows exécutez kicad.exe. Sous Linux tapez kicad dans votre
    Terminal. Vous êtes maintenant dans la fenêtre principale du gestionnaire de
    projet de KiCad. A partir de cette fenêtre, vous avez accès à huit outils
    indépendants : Eeschema, Editeur de Librairies, Pcbnew,
    Editeur d’empreintes PVB, GerbView, Bitmap2Component, PCB
    Calculator et Pl Editor. Référez-vous au diagramme précédent pour un
    aperçu de la façon d’utiliser ces différents outils.

[image: Fenêtre principale de KiCad]

	
Créez un nouveau projet :  Fichier → Nouveau Projet → Nouveau
    Projet. Nommez ce fichier de projet tutorial1. Le fichier de projet
    prend automatiquement l’extension ".pro". KiCad propose de créer un
    répertoire dédié au projet. Cliquez sur "oui" pour confirmer. Tous les
    fichiers de votre projet seront sauvegardés ici.

	
Commençons par créer un schéma de circuit. Lancer l'éditeur de schémas
    Eeschema [image: Eeschema]. C’est le premier
    bouton à gauche.

	
Cliquer sur l’icône Ajustage opt Page
    [image: Sheet settings icon] sur la barre d’outils
    située en haut. Définir le format de la page en A4 et entrer le titre
    Tute 1. Remarquez qu’il est possible de renseigner davantage le cartouche
    si besoin. Cliquez sur OK. Les informations saisies apparaissent maintenant
    dans le coin en bas à droite du cartouche. Utilisez la roulette de la souris
    pour zoomer. Sauvez le projet : Fichier → Sauver le Projet
    schématique.

	
Nous allons maintenant placer notre premier composant. Cliquez sur l’icône
    Placer un composant [image: Placer un composant] dans la barre d’outils de droite. La même fonctionnalité est
    obtenue par le raccourci clavier Ajout Composant (a).

Note
Vous pouvez voir une liste de tous les raccourcis clavier en appuyant sur la
touche ?.


	
Cliquez au milieu de la feuille. Une fenêtre Sélection Composant
    apparaît à l'écran. Nous allons placer une résistance. Tapez le R de
    Resistor pour filtrer la recherche. Vous pouvez remarquer l’entête
    device  au dessus du résistor. Cette entête device est le nom de la
    librairie à laquelle appartient ce composant. Cette librairie device est
    une librairie générique et pratique.

[image: Choose Component]

	
Double cliquez sur la résistance. La fenêtre Sélection Composant se
    ferme. Cliquez à l’endroit de la feuille où vous souhaitez placer le
    composant.

	
Cliquez sur l’icône de loupe pour zoomer sur le composant, ou utilisez la
    molette de la souris. Un clic sur la molette (bouton central) permet de se
    déplacer horizontalement ou verticalement.

	
Placez le curseur de la souris sur la résistance R et appuyez sur la
    touche r du clavier. Constatez la rotation du composant.

Note
Il n’est pas nécessaire de cliquer sur le composant pour le faire tourner.


	
Faites un clic droit au milieu du composant et choisir Editer Composant →
    Valeur. Raccourci clavier : v.  La touche e ouvre une fenêtre plus
    générale de Propriétés du Composant. Un clic droit fait apparaître le menu
    suivant avec pour chaque action son raccourci clavier.

[image: Edit component menu]

	
La fenêtre "Édition Champ Valeur" apparaît. Remplacez la valeur courante de
    R par 1k.

Note
Ne changez pas la référence (R?). Cela se fera automatiquement plus tard. La
valeur de la résistance devrait maintenant être 1k.

[image: Resistor Value]

	
Pour placer une autre résistance, cliquez à l’endroit où vous souhaitez la
    voir apparaître. La fenêtre Sélection Composant apparaîtra à nouveau.

	
La résistance que vous avez choisi précédemment apparaît dorénavant dans la
    liste Historique. Cliquez sur R puis sur OK et placez le composant.

[image: Component history]

	
Si vous souhaitez supprimer un composant, placez le curseur de la souris
    dessus. Faites un clic droit et choisissez Supprimer Composant ou bien
    appuyez sur la touche suppr.

Note
Vous pouvez éditer les raccourcis clavier en allant dans le menu
Préférences → Hotkeys → Editer hotkeys. Les modifications sont
sauvegardées immédiatement.


	
Vous pouvez également dupliquer un composant déjà présent sur la feuille en
    plaçant le curseur de la souris dessus et en utilisant la touche c. Placez
    ensuite le composant sur la feuille.

	
Faites un clic droit sur la deuxième résistance. Choisissez "Drag
    Composant". Déplacez le composant et faites un clic gauche pour le
    relâcher. La même action peut être faite en appuyant sur la touche g avec
    la souris sur le composant. Utilisez la touche "r" pour tourner le
    composant. Les touches x et y servent à faire une symétrie.

Note
Clic Droit → Déplacer Composant (équivalent à la touche m) est une autre option pour déplacer les éléments, mais il vaut mieux ne s’en servir que pour les labels et les composants non connectés. Nous verrons plus tard pourquoi.


	
Editez la valeur de la deuxième résistance avec le curseur dessus et la
    touche v. Remplacez R par 100. Vous pouvez annuler chacune de vos
    actions avec CTRL+Z.

	
Changez la taille de la grille. Vous avez probablement remarqué que tous les
    composants de la feuille schématique s’alignent sur une grille assez
    large. Vous pouvez changer le pas de la grille avec un clic droit →
    Sélection Grille. Il est généralement satisfaisant d’utiliser une
    grille de 50.0 mils pour les schémas.

	
Répétez les étapes d’ajout de composant, en sélectionnant cette fois-ci la
    librairie microchip_pic12mcu au lieu de la librairie device. Prendre le
    composant PIC12C508A-I/SN au lieu de R. Mais avant cela, ajoutez
    microchip_pic12mcu à vos fichiers de librairies de composants en allant
    dans Préférences → Librairies de Composants et cliquez sur le bouton
    Ajouter.

	
Passez la souris sur le composant microcontrôleur. Appuyez sur la touche Y
    ou X et constatez que le composant est symétrisé suivant l’axe X ou

	
Appuyez sur la même touche pour rétablir l’orientation d’origine.




	
Répétez les étapes d’ajout de composant et prenez le composant LED dans la
    librairie device.

	
Placez tous les composants de votre feuille comme ci-dessous.

[image: 1000000000000279000001D2A3715F27_png]

	
Il s’agit maintenant de créer le composant schématique MYCONN3 pour notre
    connecteur à 3 pins. Vous pouvez sauter à la section
    Make Schematic Components in KiCad
    pour apprendre à le créer à partir de zéro, puis revenir ici pour continuer
    la carte.

	
Vous pouvez désormais placer ce nouveau composant. Appuyez sur la touche a
    et prenez le composant MYCONN3 dans la librairie myLib .

	
La référence de composant J? devrait apparaître sous le label
    MYCONN3. Si vous voulez changer sa position, faites un clic droit sur J?
    et choisissez Déplacer Référence ou appuyez sur la touche M. Pensez à
    zoomer si besoin. Déplacez J? sous le composant comme sur l’image
    suivante. Les labels peuvent être déplacés autant de fois que nécessaire.

[image: 10000000000000950000007B843ADE6A_png]

	
Il nous faut maintenant placer les symboles d’alimentation et de
    masse. Cliquez sur Placer un symbole type power
    [image: add_power_png] dans la barre de droite, ou
    bien appuyez sur la touche p. Dans la fenêtre Sélection Composant,
    choisissez le symbole VCC à partir de la librairie power. Valider.

	
Cliquez à proximité de la broche du résistor de 1k pour placer
    VCC. Recommencez très rapidement la même opération pour la broche VDD du
    microcontrôleur ainsi que pour la broche VCC de MYCONN3 en utilisant le
    répertoire historique dans la fenêtre sélection de composant.

	
Répétez les étapes précédentes en sélectionnant maintenant GND. Placez GND à
    proximité de MYCONN3 ainsi que de la broche VSS du microcontrôleur.  Vôtre
    schéma devrait se présenter ainsi :

[image: 1000000000000303000002A0130916D9_png]

	
Maintenant, nous allons relier tous nos compsants. Cliquez sur Placer un
    fil  [image: Place wire]  dans la barre d’outils de
    droite.

Note
Veillez à ne pas choisir Placer un bus qui apparaît juste en
dessous. L’icône représente un fil bleu plus épais. Les bus seront évoqués
dans la section Bus Connections in KiCad.


	
Cliquez sur le petit cercle situé à l’extrémité de la broche 7 du
    microcontrôleur puis sur le petit cercle de la broche 2 de la LED. N’hésitez
    pas à zoomer pendant cette opération.

Note
Si vous souhaitez repositionner des composants connectés par un ou plusieurs
fils, il faut utiliser la touche g (drag) et non la touche m
(déplacer). Sinon, les fils ne suivent pas le composant. Retournez à l'étape
24 si vous avez oublié comment déplacer un composant.

[image: 1000000000000134000000D9A9B4ED54_png]

	
Répétez cette opération et connectez tous les composants comme indiqué
    ci-dessous.  Un double clic suffit pour terminer un fil. Pour relier les
    symboles VCC et GND, les fils doivent toucher le bas du symbole VCC et le
    milieu du symbole GND. Voir l’image ci-dessous.

[image: 100000000000033200000294961F4BAD_png]

	
We will now consider an alternative way of making a connection using
    labels. Pick a net labelling tool by clicking on the Place net name icon
    [image: add_line_label_png] on the right
    toolbar. You can also use the l key.

	
Cliquez sur le fil connecté à la broche 6 du microcontrôleur. Nommez ce
    label INPUT.

	
Procédez de la même façon pour placer un label à droite du résistor de 100
    Ohms. Nommez le également INPUT. Ces deux labels ayant le même nom, la
    broche 6 du microcontrôleur et la résistance de 100 Ohms sont maintenant
    reliés de manière invisible. C’est une technique très pratique quand les
    connexions sont nombreuses et que la présence de fils peut rendre la lecture
    du schéma difficile. Il n’est pas nécessaire d’avoir un fil pour placer un
    label. Vous pouvez attacher un label à une broche.

	
Les labels peuvent également être utilisés dans le but de renseigner le
    schéma. Placez un label sur la broche 7 du PIC. Entrez le nom
    uCtoLED. Nommez le fil entre le resistor et la LED LEDtoR. Nommez le fil
    entre MYCONN3 et le resistor INPUTtoR.

	
Il n’est pas nécessaire de nommer les fils reliés à VCC et GND. En effet,
    les fils connectés aux objets power sont nommés automatiquement.

	
Votre schéma devrait maintenant ressembler à celui ci-dessous.

[image: 1000000000000340000002A2DDE0F6DA_png]

	
Intéressons-nous maintenant aux broches non connectées. Les broches ou fils
    qui ne sont pas connectés génèrent une mise en garde lors de la vérification
    par KiCad. Pour éviter ces messages de mise en garde, vous pouvez préciser
    que le choix de ne pas connecter les fils est délibéré ou bien indiquer
    manuellement chaque absence de connexion.

	
Click on the Place no connect flag icon
    [image: noconn_png] on the right toolbar. Click on
    pins 2, 3, 4 and 5. An X will appear to signify that the lack of a wire
    connection is intentional.

[image: 10000000000001C8000000FEEDCB5FB8_png]

	
Some components have power pins that are invisible. You can make them
    visible by clicking on the Show hidden pins icon
    [image: hidden_pin_png] on the left
    toolbar. Hidden power pins get automatically connected if VCC and GND naming
    is respected. Generally speaking, you should try not to make hidden power
    pins.

	
Il est maintenant nécessaire d’ajouter un Power Flag pour indiquer à KiCad
    d’où proviennent les alimentations. Appuyez sur la touche a, sélectionnez
    Liste tous, double-cliquez sur la librairie power et cherchez
    PWR_FLAG. Placez-en deux et connectez-les aux broches GND et VCC comme
    indiqué ci-dessous.

[image: 100000000000010700000125A4376EBB_png]
Note
This will avoid the classic schematic checking warning: Warning Pin power_in
not driven (Net xx)


	
Sometimes it is good to write comments here and there. To add comments on
    the schematic use the Place graphic text (comment) icon
    [image: add_text_png] on the right toolbar.

	
All components now need to have unique identifiers. In fact, many of our
    components are still named R? or J?. Identifier assignation can be done
    automatically by clicking on the Annotate schematic icon
    [image: annotate_png].

	
Dans la fenêtre Annotation de la schématique, sélectionnez Utiliser la
    schématique entière' et cliquez sur Numérotation. Cliquez sur OK pour
    confirmer le message qui apparaît. Remarquez que tous les ? ont été
    remplacés par des nombres. Chaque identifiant est maintenant unique. Dans
    notre exemple, ils ont été renommés R1, R2, U1, D1 et J1.

	
Vérifions maintenant l’absence d’erreurs. Cliquez sur Exécuter le test des
    règles électriques [image: erc_png]. Cliquez sur
    Exécuter dans l’onglet ERC. Un rapport vous informe des erreurs ou mises
    en garde (warnings) telles que des fils non connectés par exemple. Vous
    devriez avoir 0 erreurs et 0 warnings. Dans le cas contraire, une petite
    flèche verte apparaît sur le schéma à l’endroit correspondant à l’erreur ou
    la mise en garde. Cochez la case Créer fichier rapport ERC et cliquez à
    nouveau sur Exécuter pour obtenir un rapport plus détaillé.

	
Le schéma est maintenant terminé. Nous pouvons maintenant créer un fichier
    Netliste dans lequel nous ajouterons les empreintes des composants. Cliquez
    sur Génération de la Netliste [image: netlist_png]
    sur la barre d’outils du haut. Cliquez sur Générer puis sauvegardez sous
    le nom proposé.

	
After generating the Netlist file, click on the Run Cvpcb icon
    [image: cvpcb_png] on the top toolbar. If a missing
    file error window pops up, just ignore it and click OK.

	
Cvpcb vous permet d’associer à chaque composant de votre schéma une
    empreinte d’une des librairies de KiCad. Plusieurs zones apparaissent. Dans
    celle du milieu sont listés tous les composants de votre schéma. Cliquez sur
    D1. Dans la zone de droite apparaissent toutes les empreintes
    disponibles. Sélectionnez  LEDs:LED-5MM par un double-clic.

[image: cvpcb_png]

	
It is possible that the pane on the right shows only a selected subgroup of
    available footprints. This is because KiCad is trying to suggest to you a
    subset of suitable footprints. Click on the icons
    [image: module_filtered_list_png],
    [image: module_pin_filtered_list_png]
    and [image: module_library_list_png] to
    enable or disable these filters.

	
Pour IC1 choisir l’empreinte Housings_DIP:DIP-8_W7.62mm.  Pour J1
    choisir l’empreinte Connect:Banana_Jack_3Pin .  Pour R1 et R2 choisir
    l’empreinte Discret:R1.

	
Pour voir à quoi ressemblent les empreintes qui vous sont proposées, vous
    avez deux solutions. Vous pouvez cliquer sur Affichage empreinte
    sélectionnée [image: show_footprint_png] pour
    voir l’empreinte courante. Vous pouvez également cliquer sur Montrer
    documentation des modules [image: datasheet_png]
    qui ouvre un document PDF de plusieurs pages dans lequel apparaissent toutes
    les empreintes disponibles. Vous pouvez l’imprimer et vérifier ainsi que les
    dimensions correspondent avec celles de votre composant.

	
You are done. You can now update your netlist file with all the associated
    footprints. Click on File → Save As. The default name tutorial1.net
    is fine, click save. Otherwise you can use the icon
    [image: Save icon].  Your netlist file has now been
    updated with all the footprints. Note that if you are missing the footprint
    of any device, you will need to make your own footprints. This will be
    explained in a later section of this document.

	
Vous pouvez fermer Cvpcb et retourner à l'éditeur de schématique
    Eeschema. Enregistrer le projet en cliquant sur Fichier → Sauver le
    projet schématique. Fermez l'éditeur de schématique.

	
Basculez vers le manager de projet KiCad.

	
Le fichier netliste décrit tous les composants ainsi que les connections de
    leurs broches. C’est un fichier au format texte que vous pouvez facilement
    éditer.

Note
Les fichiers librairies (*.lib) sont également au format texte et
facilement éditables.


	
Pour créer une liste du matériel (Bill Of Materials : BOM), allez dans
    Eeschema et cliquez sur l’icône Génération de la liste des composants et/ou
    références croisées [image: bom_png] sur la barre
    d’outils du haut. Il n’y a pas de plugin actif par défaut. Ajoutez-en un en
    cliquant sur ajouter plugin. Sélectionnez le fichier *.xsl que vous
    souhaitez utiliser. Dans cet exercice, nous choisissons bom2csv.xsl.

Note
Le fichier *.xsl se trouve dans le répertoire d’installation de KiCad
plugins qui se trouve à l’emplacement : /usr/lib/kicad/plugins/.
Obtenez également ce fichier en allant à :
wget https://raw.githubusercontent.com/KiCad/kicad-source-mirror/master/eeschema/plugins/bom2csv.xsl

KiCad génère automatiquement les commandes. Par exemple : 

xsltproc -o "%O" "/home/<user>/kicad/eeschema/plugins/bom2csv.xsl" "%I"


Si vous souhaitez ajouter l’extension, remplacer la commande par : 

xsltproc -o "%O.csv" "/home/<user>/kicad/eeschema/plugins/bom2csv.xsl" "%I"


Appuyer sur la touche d’aide pour avoir plus d’informations.

	
Appuyer sur Générer. Le fichier (qui porte le même nom que le projet) se
    trouve dans le répertoire du projet. Ouvrez le fichier *.csv avec
    LibreOffice Calc ou Excel. Une fenêtre d’import apparaît, appuyez sur OK.



Vous êtes maintenant prêt-e à passer à la partie circuit-imprimé (PCB) qui
suit. Jetons auparavant un rapide coup d’oeil à la façon de connecter des
broches en utilisant un bus.

3.2. Connexions par bus avec KiCad



Sometimes you might need to connect several sequential pins of component A
with some other sequential pins of component B. In this case you have two
options: the labelling method we already saw or the use of a bus
connection. Let’s see how to do it.
	
Let us suppose that you have three 4-pin connectors that you want to connect
    together pin to pin. Use the label option (press the l key) to label pin 4
    of the P4 part. Name this label a1. Now let’s press the Ins key to have
    the same item automatically added on the pin below pin 4 (PIN 3). Notice how
    the label is automatically renamed a2.

	
Press the Ins Key two more times. The Ins key corresponds to the action
    Repeat last item and it is an infinitely useful command that can make your
    life a lot easier.

	
Repeat the same labelling action on the two other connectors CONN_2 and
    CONN_3 and you are done. If you proceed and make a PCB you will see that the
    three connectors are connected to each other. Figure 2 shows the result of
    what we described. For aesthetic purposes it is also possible to add a
    series of Place wire to bus entry using the icon
    [image: Place wire to bus entry] and bus line
    using the icon [image: Place bus to bus entry],
    as shown in Figure 3. Mind, however, that there will be no effect on the
    PCB.

	
It should be pointed out that the short wire attached to the pins in Figure
    2 is not strictly necessary. In fact, the labels could have been applied
    directly to the pins.

	
Let’s take it one step further and suppose that you have a fourth connector
    named CONN_4 and, for whatever reason, its labelling happens to be a little
    different (b1, b2, b3, b4). Now we want to connect Bus a with Bus b in a
    pin to pin manner. We want to do that without using pin labelling (which is
    also possible) but by instead using labelling on the bus line, with one
    label per bus.

	
Connect and label CONN_4 using the labelling method explained before. Name
    the pins b1, b2, b3 and b4. Connect the pin to a series of Wire to bus
    entry using the icon [image: add_line2bus_png]
    and to a bus line using the icon
    [image: add_bus_png]. See Figure 4.

	
Put a label (press the l key option) on the bus of CONN_4 and name it
    b[1..4].

	
Put a label (press the l key option) on the previous a bus and name it
    a[1..4].

	
What we can now do is connect bus a[1..4] with bus b[1..4] using a bus line
    with the button [image: add_bus_png].

	
By connecting the two buses together, pin a1 will be automatically connected
    to pin b1, a2 will be connected to b2 and so on. Figure 4 shows what the
    final result looks like.

Note
The Repeat last item option accessible via the Ins key can be successfully
used to repeat period item insertions. For instance, the short wires
connected to all pins in Figure 2, Figure 3 and Figure 4 have been placed
with this option.


	
The Repeat last item option accessible via the Ins key has also been
    extensively used to place the many series of Wire to bus entry using the
    icon [image: add_line2bus_png].

[image: 10000000000004A2000001E05B3D8DFF_png]




Chapitre 4. Router le circuit imprimé (PCB)



Nous allons maintenant utiliser la netliste générée précédemment pour router
le PCB. Utiliser l’outil PCBnew.

4.1. Utiliser Pcbnew



	
From the KiCad project manager, click on the Pcbnew icon
    [image: pcbnew_png]. The Pcbnew window will open. If
    you get an error message saying that a *.kicad_pcb file does not exist and
    asks if you want to create it, just click Yes.

	
Commencez par saisir des informations sur la feuille. Cliquez sur l’icône
    Ajustage de la feuille de dessin (dimensions et textes)
    [image: sheetset_png] sur la barre d’outils du
    haut. Définir la Taille de la page en A4 et saisissez dans titre :
    Tutorial1.

	
C’est une bonne idée de commencer par configurer l’isolation et la largeur
    de piste minimale aux valeurs requises par votre fabricant de PCB. Vous
    pouvez généralement configurer l’isolation à 0.25 et la largeur de piste
    minimale à 0.25. Cliquez sur le menu Règles de conception → Règles de
    conception. S’il n’apparaît pas déjà, cliquez sur l’onglet Editeur de
    NetClasses. Dans les champs en haut de la fenêtre, modifiez l'Isolation
    par 0.25 et la largeur de piste par 0.25 comme indiqué ci-après. Les
    mesures sont en mm.

[image: Design Rules Window]

	
Cliquez sur l’onglet Règles générales et définir Largeur Min Piste à
    0.25. Valider ces changements en cliquant sur OK.

	
Nous allons maintenant importer la netliste. Cliquez sur l’icône Lire
    Netliste [image: netlist_png] dans la barre d’outils
    du haut. Cliquez sur le bouton Examiner, sélectionnez tutorial1.net et
    cliquez sur Lire Netliste Courante. Cliquer sur Fermer pour terminer.

	
Tous les composants doivent maintenant apparaître dans le coin en haut à
    gauche, juste au dessus du cartouche. Utilisez la molette si vous ne les
    voyez pas.

	
Sélectionnez tous les composants à l’aide de la souris et placez les au
    milieu de la carte. Vous pouvez utilisez la molette de la souris pendant le
    déplacement des composants.

	
All components are connected via a thin group of wires called
    ratsnest. Make sure that the Hide board ratsnest button
    [image: general_ratsnest_png] is pressed. In
    this way you can see the ratsnest linking all components.

Note
L’infobulle du bouton indique quelle action sera obtenue après avoir cliqué
dessus.


	
Vous pouvez déplacer chaque composant en le survolant et en appuyant sur la
    touche g. Cliquez ensuite à l’endroit où vous souhaitez les placer. Déplacer
    les composants jusqu'à ce vous ayez minimisé le nombre de croisements des
    fils.

Note
Si à la place d’utiliser la commande Drag (touche g) vous utilisez la
commande Déplacer (touche m), vous vous rendrez compte par la suite que les
connexions sont alors perdues (comme dans Eeschema). Dans les lignes qui
suivent, nous utiliserons systématiquement la touche g.

[image: 10000000000001FD000001B15F2BA74A_png]

	
Si le chevelu disparaît ou que l'écran devient brouillon, faites un
    clic-droit et cliquez sur Rafraîchir l'écran. Remarquez qu’une des broches
    des la résistance de 100 ohms est connectée à la broche 6 du composant
    PIC. Ceci est le résultat de la méthode de connexion des pins à l’aide des
    Labels. Les Labels sont souvent préférés aux fils car ils permettent de
    rendre le schéma plus lisible.

	
Définissons maintenant le contour du PCB. Sélectionnez la couche Edge.Cuts
    à partir du menu déroulant dans la barre d’outils du haut. Cliquez sur
    l’icône Eddition de lignes ou de polygones graphiques
    [image: add_dashed_line_png] sur la barre
    d’outils de droite. Tracer le contour de la carte en cliquant à chacun des
    coins.

	
Nous allons par la suite connecter tous les fils à l’exception de GND. Nous
    réaliserons la connection de tous les GND en une seule fois en utilisant un
    plan de masse sur la partie cuivre située sous la carte (appelée B.Cu).

	
Choisissons maintenant la couche de cuivre sur laquelle nous souhaitons
    travailler. Sélectionnez la couche F.Cu (PgUp) dans le menu déroulant de
    la barre d’outils du haut. C’est la couche de cuivre du dessus du PCB.

[image: Select the Front top copper layer]

	
Si vous décidez, par exemple, de faire un PCB de 4 couches, allez dans
    Règjes de conception → Options couches et remplacez la valeur du champ
    Couches Cuivre par 4. Vous pouvez nommer les couches dans le tableau et
    définir leur usage. Notez qu’il y a des préconfigurations très utiles qui
    peuvent être sélectionnées à l’aide du menu Groupes Prédéterminés de
    Couches.

	
Click on the Add Tracks and vias icon
    [image: add_tracks_png] on the right
    toolbar. Click on pin 1 of J1 and run a track to pad R2. Double-click to
    set the point where the track will end. The width of this track will be the
    default 0.250 mm. You can change the track width from the drop-down menu in
    the top toolbar. Mind that by default you have only one track width
    available.

[image: pcbnew_1_png]

	
Si vous souhaitez ajouter davantage de largeurs de pistes, allez jusqu'à
    l’onglet : Règles de conception → Règles de conception → Règles
    générales. Ajoutez, dans le quart inférieur droit de cette fenêtre, les
    autres largeurs que vous souhaitez voir apparaître. Vous les verrez ensuite
    apparaître dans le menu déroulant pendant que vous routez votre carte. Voir
    l’exemple ci-dessous (en pouces ou inches).

[image: 1000000000000169000001178613965A_png]

	
Une autre méthode consiste à ajouter une NetClasse pour laquelle vous
    spécifiez certaines options. Allez dans Règles de conception →  Règles
    de conception → Editeur de NetClasss et ajouter une nouvelle classe
    appelée power. Remplacez l'épaisseur de piste de 8 mil (noté 0.0080) par
    24 mil (notée 0.0240).  Ajoutez ensuite tout sauf la masse à la classe
    power (sélectionnez défaut à gauche et power à droite puis utilisez
    les flèches).

	
Si vous souhaitez changer le pas de la grille, clic-droit → Sélection
    Grille. Assurez-vous d’avoir choisi le pas de grille approprié avant ou
    après le placement des composants et la réalisation des pistes.

	
Répétez cette opération jusqu'à ce que tous les fils, à l’exception de la
    broche 3 de J1, soient connectés. Votre carte devrait ressembler à l’exemple
    ci-dessous.

[image: 10000000000001F8000001B32F1802F1_png]

	
Dessinons maintenant une piste sur l’autre face de cuivre du
    PCB. Sélectionnez B.Cu dans le menu déroulant de la barre d’outils du
    haut. Cliquez sur l’icône ajouter pistes et vias. Dessinez une piste entre
    la broche 3 de J1 et la broche 8 de U1. Cette connexion n’est pas nécessaire
    puisque que nous pourrions la réaliser avec le plan de masse. Observez le
    changement de couleur de la piste.

	
Aller de la broche A à la broche B en changeant de couche.
     Il est possible de changer de couche de cuivre pendant que vous
    tracez une piste en plaçant un via. Pendant que vous tracez une
    piste sur la couche de cuivre du dessus faites un clic-droit et
    choisissez Placer Via Traversante ou la touche v. Vous vous
    trouvez alors sur la couche de dessous où vous pouvez
    poursuivre le tracé de la piste.

[image: 100000000000026E000002155D41D893_png]

	
Si vous voulez inspecter une connexion, vous pouvez cliquer sur l’icône
    Surbrillance Net [image: net_highlight_png]
    sur la barre d’outils de droite.  Cliquez sur la broche 3 de J1. La piste et
    toutes les pastilles connectées devraient apparaître en surbrillance.

	
Nous allons maintenant réaliser un plan de masse qui sera conneté à toutes
    les broches reliées à GND. Cliquez sur l’icône Addition de zones remplies
    [image: add_zone_png] sur la barre d’outils de
    droite. Nous allons tracer un rectangle autour de la carte. Cliquez à
    l’endroit où vous souhaitez placer un coin de ce rectangle. Dans la boîte de
    dialogue qui apparaît, configurez la Connexion des pads en frein
    thermique et la Direction des contours en H/V et 45 deg
    seulement. Validez.

	
Tracez le rectangle en suivant le contour de la carte en cliquant à chacun
    de ses coins. Faites un double-clic pour terminer le rectangle. Faites un
    clic-droit sur le contour que vous venez de tracer (appuyez sur la touche
    Echap et recommencez si la commande Zones n’apparaît pas. Cliquez alors
    sur Contour de Zone ). Cliquez sur Zones → Remplir zone. La carte
    devrait se remplir de vert et ressemblez à ceci :

[image: 10000000000001830000015C1D559586_png]

	
Run the design rules checker by clicking on the Perform Design Rules Check
    icon [image: drc_png] on the top toolbar.  Click on
    Start DRC. There should be no errors. Click on List Unconnected. There
    should be no unconnected track. Click OK to close the DRC Control dialogue.

	
Enregistrez votre fichier en cliquant sur Fichiers → Sauver. Pour
    admirer votre carte en 3D, cliquez sur Affichage → 3D Visualisateur.

[image: pcbnew_3d_viewer_png]

	
Pour faire tourner le PCB, maintenez le bouton gauche de la souris appuyé
    puis la déplacer.

	
Votre carte est terminée. Pour l’envoyer à votre fabricant de PCB, il vous
    faudra générer les fichiers Gerber.




4.2. Générer les fichiers Gerber



Une fois que votre PCB est complet, vous pouvez générer des fichiers Gerber
pour chaque couche et les envoyer à votre fabricant de PCB favorit qui
fabriquera la carte pour vous.
	
A partir de KiCad, ouvrez Pcbnew et chargez le fichier de votre carte en
    cliquant sur l’icône
    [image: open_document_png].

	
Cliquez sur Fichier →Tracer. Sélectionnez Gerber dans Format de
    tracé et sélectionnez le dossier dans lequel les fichiers Gerber seront
    déposés. Cliquez sur le bouton Tracer pour l’exécution.

	
Voici les couches que vous avez typiquement besoin de sélectionner pour
    fabriquer un PCB double-face :



	Layer 	KiCad Layer Name 	Old KiCad Layer Name 	Default Gerber Extension
    	"Use Protel filename extensions" is enabled
	Bottom Layer
	B.Cu
	Copper
	.GBR
	.GBL

	Top Layer
	F.Cu
	Component
	.GBR
	.GTL

	Top Overlay
	F.SilkS
	SilkS_Cmp
	.GBR
	.GTO

	Bottom Solder Resist
	B.Mask
	Mask_Cop
	.GBR
	.GBS

	Top Solder Resist
	F.Mask
	Mask_Cmp
	.GBR
	.GTS

	Edges
	Edge.Cuts
	Edges_Pcb
	.GBR
	.GM1




4.3. Utiliser GerbView\



	
To view all your Gerber files go to the KiCad project manager and click on
    the GerbView icon.  On the drag down menu select Layer 1. Click on
    File → Load Gerber file or click on the icon
    [image: gerber_file_png]. Load all generated
    Gerber files one at a time. Note how they all get displayed one on top of
    the other.

	
Utilisez le menu à droite pour activer/désactiver les couches
    visibles. Inspectez minutieusement chaque couche avant de lancer la
    production.

	
Pour générer le fichier de perçage, utilisez à nouveau la commande Fichier
    →Tracer dans Pcbnew. Les réglages par défaut devraient être
    satisfaisants.




4.4. Router automatiquement avec FreeRouteur



Routing a board by hand is quick and fun, however, for a board with lots of
components you might want to use an autorouter. Remember that you should
first route critical traces by hand and then set the autorouter to do the
boring bits. Its work will only account for the unrouted traces. The
autorouter we will use here is FreeRouter from freerouting.net.
Note
Freerouter is a open source java application, and it is needed to build by
yourself to use with KiCad.  Source code of Freerouter can be found on this
site: https://github.com/nikropht/FreeRouting

	
From Pcbnew click on File → Export → Specctra DSN or click on
    Tools → FreeRoute → Export a Specctra Design (*.dsn) file and save
    the file locally.  Launch FreeRouter and click on the Open Your Own Design
    button, browse for the dsn file and load it.

Note
The Tools → FreeRoute dialog has a nice help button that opens a file
viewer with a little document inside named Freerouter Guidelines. Please
follow these guidelines to use FreeRoute effectively.


	
FreeRouter has some features that KiCad does not currently have, both for
    manual routing and for automatic routing. FreeRouter operates in two main
    steps: first, routing the board and then optimising it. Full optimisation
    can take a long time, however you can stop it at any time need be.

	
You can start the automatic routing by clicking on the Autorouter button
    on the top bar. The bottom bar gives you information about the on-going
    routing process. If the Pass count gets above 30, your board probably can
    not be autorouted with this router. Spread your components out more or
    rotate them better and try again. The goal in rotation and position of parts
    is to lower the number of crossed airlines in the ratsnest.

	
Making a left-click on the mouse can stop the automatic routing and
    automatically start the optimisation process. Another left-click will stop
    the optimisation process. Unless you really need to stop, it is better to
    let FreeRouter finish its job.

	
Click on the File → Export Specctra Session File menu and save the
    board file with the .ses extension. You do not really need to save the
    FreeRouter rules file.

	
Back to Pcbnew. You can import your freshly routed board by clicking on
    the link Tools → FreeRoute and then on the icon Back Import the
    Spectra Session (.ses) File and selecting your .ses file.



If there is any routed trace that you do not like, you can delete it and
re-route it again, using the del key and the routing tool, which is the Add
tracks icon [image: Add Track icon] on the right
toolbar.

Chapitre 5. Les annotations dans KiCad



Once you have completed your electronic schematic, the footprint assignment,
the board layout and generated the Gerber files, you are ready to send
everything to a PCB manufacturer so that your board can become reality.
Often, this linear work-flow turns out to be not so uni-directional. For
instance, when you have to modify/extend a board for which you or others
have already completed this work-flow, it is possible that you need to move
components around, replace them with others, change footprints and much
more. During this modification process, what you do not want to do is to
re-route the whole board again from scratch. Instead, this is how you do it:
	
Let’s suppose that you want to replace a hypothetical connector CON1 with
    CON2.

	
You already have a completed schematic and a fully routed PCB.

	
From KiCad, start Eeschema, make your modifications by deleting CON1 and
    adding CON2. Save your schematic project with the icon
    [image: Save icon] and c lick on the Netlist
    generation icon [image: netlist_png] on the top
    toolbar.

	
Click on Netlist then on save. Save to the default file name.  You have
    to rewrite the old one.

	
Now assign a footprint to CON2. Click on the Run Cvpcb icon
    [image: cvpcb] on the top toolbar. Assign the footprint
    to the new device CON2. The rest of the components still have the previous
    footprints assigned to them. Close Cvpcb.

	
Back in the schematic editor, save the project by clicking on File →
    Save Whole Schematic Project. Close the schematic editor.

	
From the KiCad project manager, click on the Pcbnew icon. The Pcbnew
    window will open.

	
The old, already routed, board should automatically open. Let’s import the
    new netlist file. Click on the Read Netlist icon
    [image: netlist_png] on the top toolbar.

	
Click on the Browse Netlist Files button, select the netlist file in the
    file selection dialogue, and click on Read Current Netlist.  Then click
    the Close button.

	
At this point you should be able to see a layout with all previous
    components already routed. On the top left corner you should see all
    unrouted components, in our case the CON2. Select CON2 with the mouse.  Move
    the component to the middle of the board.

	
Place CON2 and route it. Once done, save and proceed with the Gerber file
    generation as usual.



The process described here can easily be repeated as many times as you
need. Beside the Forward Annotation method described above, there is another
method known as Backward Annotation. This method allows you to make
modifications to your already routed PCB from Pcbnew and updates those
modifications in your schematic and netlist file. The Backward Annotation
method, however, is not that useful and is therefore not described here.

Chapitre 6. Créer le symbole d’un composant avec KiCad



Le composant que vous voulez placer sur votre schéma n’est parfois pas dans
les librairies KiCad. C’est relativement normal et il n’y a pas de raison de
s’en inquiéter. Nous allons voir dans cette section comment créer rapidement
un nouveau symbole de composant avec KiCad.
http://per.launay.free.fr/kicad/kicad_php/composant.php
Dans KiCad, un composant est un morceau de texte qui commence par DEF et
termine par ENDDEF. Un ou plusieurs composants sont normalement présents
dans un fichier librairie qui porte l’extension .lib. Si vous voulez
ajouter des composants à un fichier librairie, vous pouvez simplement
utiliser les commandes copier et coller.

6.1. Utiliser l’Editeur des Librairies Schématiques



	
Nous pouvons utiliser l'Editeur des Librairies Schématiques (qui
    appartient à Eeschema) pour dessiner de nouveau composants. Créons un
    répertoire nommé librairie dans notre répertoire de projet
    tutorial1. Nous y déposerons notre nouveau fichier librairie maLib.lib
    dès que nous créé notre nouveau composant.

	
Now we can start creating our new component. From KiCad, start Eeschema,
    click on the Library Editor icon
    [image: libedit_png] and then click on the New
    component icon [image: new_component_png]. The
    Component Properties window will appear. Name the new component MYCONN3,
    set the Default reference designator as J, and the Number of parts per
    package as 1. Click OK. If the warning appears just click yes.  At this
    point the component is only made of its labels. Let’s add some pins. Click
    on the Add Pins icon [image: pin_png] on the right
    toolbar. To place the pin, left click in the centre of the part editor sheet
    just below the MYCONN3 label.

	
Dans la fenêtre Propriétés des pins qui apparaît, affectez VCC à Nom
    pin, 1 à Numéro de pin et Passive à Type électrique. Cliquez
    ensuite sur OK.

[image: Pin Properties]

	
Placez la broche en cliquant à l’endroit où vous souhaitez qu’elle
    apparaisse, à droite et en dessous de l'étiquette MYCONN3.

	
Répétez les étapes précédentes en affectant cette fois INPUT à Nom pin,
    2 à Numéro de pin et Passive à type électrique.

	
Répétez les étapes précédentes en affectant cette fois GND à Nom pin,
    3 à Numéro de pin et Passive à type électrique. Alignez et ordonnez
    les broches. L'étiquette du composant MYCONN3 devrait être au milieu de la
    page (à l’intersection des lignes bleues).

	
Dessinez ensuite le contour du composant. Cliquez sur l’icône Ajouter des
    rectangles graphiques
    [image: add_rectangle_png]. Nous voulons
    dessiner un rectangle à côté des broches comme représenté ci-dessous. Pour
    se faire, cliquez à l’endroit où vous souhaitez placer le coin supérieur
    gauche du rectangle. Cliquez ensuite à l’endroit où vous souhaitez placer le
    coin inférieur droit.

[image: 10000000000000DD000000946E66C399_png]

	
Cliquez sur l’icône Sauver le composant courant dans une nouvelle
    librairie  [image: new_library_png], naviguez
    jusqu’au répertoire tutorial1/librairie et sauvez la nouvelle librairie en
    lui donnant le nom maLib.lib.

	
Allez dans Préférences → Librairies de Composants et ajoutez à la fois
    tutorial1/librairie/ dans Chemin de recherche défini par l’utilisateur
    et maLib.lib dans Fichiers Librairies de Composants.

	
Click on the Select working library icon
    [image: library_png]. In the Select Library window
    click on myLib and click OK. Notice how the heading of the window
    indicates the library currently in use, which now should be myLib.

	
Click on the Update current component in current library icon
    [image: save_part_in_mem_png] in the top
    toolbar. Save all changes by clicking on the Save current loaded library on
    disk icon [image: save_library_png] in the top
    toolbar. Click Yes in any confirmation messages that appear.  The new
    schematic component is now done and available in the library indicated in
    the window title bar.

	
Vous pouvez maintenant fermer l’Editeur de composants. Vous allez retourner
    dans la fenêtre de l'éditeur de schéma. Votre nouveau composant sera
    maintenant disponible à partir de la librairie maLib.

	
Vous pouvez rendre accessible n’importe quel fichier librairie file.lib en
    l’ajoutant au chemin d’accès aux librairies. Dans Eeschema, allez dans
    Préférences → Librairies de Composants et ajoutez à la fois son chemin
    d’accès dans Chemin de recherche défini par l’utilisateur et file.lib
    dans Fichiers Librairies de Composants.




6.2. Eporter, Importer et modifier une librairie



Instead of creating a library component from scratch it is sometimes easier
to start from one already made and modify it. In this section we will see
how to export a component from the KiCad standard library device to your
own library myOwnLib.lib and then modify it.
	
From KiCad, start Eeschema, click on the Library Editor icon
    [image: libedit_png], click on the Select working
    library icon [image: library_png] and choose the
    library device. Click on Load component to edit from the current lib
    icon [image: import_cmp_from_lib_png] and
    import the RELAY_2RT.

	
Click on the Export component icon
    [image: export_png], navigate into the library/
    folder and save the new library file with the name myOwnLib.lib.

	
You can make this component and the whole library myOwnLib.lib available
    to you by adding it to the library path. From Eeschema, go to
    Preferences → Component Libraries and add both library/ in User
    defined search path and myOwnLib.lib in the Component library files.

	
Click on the Select working library icon
    [image: library_png]. In the Select Library window
    click on myOwnLib and click OK. Notice how the heading of the window
    indicates the library currently in use, it should be myOwnLib.

	
Click on the Load component to edit from the current lib icon
    [image: import_cmp_from_lib_png] and
    import the RELAY_2RT.

	
You can now modify the component as you like. Hover over the label
    RELAY_2RT, press the e key and rename it MY_RELAY_2RT.

	
Click on Update current component in current library icon
    [image: save_part_in_mem_png] in the top
    toolbar. Save all changes by clicking on the Save current loaded library on
    disk icon [image: save_library_png] in the top
    toolbar.




6.3. Créer le symbole d’un composant avec quicklib



This section presents an alternative way of creating the schematic component
for MYCONN3 (see MYCONN3 above) using the Internet tool
quicklib.
	
Allez vers la page quicklib : http://kicad.rohrbacher.net/quicklib.php

	
Fill out the page with the following information: Component name: MYCONN3
    Reference Prefix: J Pin Layout Style: SIL Pin Count, N: 3

	
Click on the Assign Pins icon. Fill out the page with the following
    information: Pin 1: VCC Pin 2: input Pin 3: GND.  Type : Passive for all 3
    pins.

	
Click on the icon Preview it and, if you are satisfied, click on the
    Build Library Component. Download the file and rename it
    tutorial1/library/myQuickLib.lib.. You are done!

	
Have a look at it using KiCad. From the KiCad project manager, start
    Eeschema, click on the Library Editor icon
    [image: libedit_png], click on the Import Component
    icon [image: import_png], navigate to
    tutorial1/library/ and select myQuickLib.lib.

[image: 10000000000002EE00000177A7337383_png]

	
You can make this component and the whole library myQuickLib.lib available
    to you by adding it to the KiCad library path. From Eeschema, go to
    Preferences → Component Libraries and add library in User defined
    search path and myQuickLib.lib in Component library files.



As you might guess, this method of creating library components can be quite
effective when you want to create components with a large pin count.

6.4. Make a high pin count schematic component



In the section titled Make Schematic Components in quicklib we saw how to
make a schematic component using the quicklib web-based tool.  However,
you will occasionally find that you need to create a schematic component
with a high number of pins (some hundreds of pins). In KiCad, this is not a
very complicated task.
	
Suppose that you want to create a schematic component for a device with 50
    pins. It is common practise to draw it using multiple low pin-count
    drawings, for example two drawings with 25 pins each. This component
    representation allows for easy pin connection.

	
The best way to create our component is to use quicklib to generate two
    25-pin components separately, re-number their pins using a Python script and
    finally merge the two by using copy and paste to make them into one single
    DEF and ENDDEF component.

	
You will find an example of a simple Python script below that can be used in
    conjunction with an in.txt file and an out.txt file to re-number the
    line: X PIN1 1 -750 600 300 R 50 50 1 1 I into X PIN26 26 -750 600 300 R
    50 50 1 1 I this is done for all lines in the file in.txt.



Simple script. 

#!/usr/bin/env python
''' simple script to manipulate KiCad component pins numbering'''
import sys, re
try:
    fin=open(sys.argv[1],'r')
    fout=open(sys.argv[2],'w')
except:
    print "oh, wrong use of this app, try:", sys.argv[0], "in.txt out.txt"
    sys.exit()
for ln in fin.readlines():
    obj=re.search("(X PIN)(\d*)(\s)(\d*)(\s.*)",ln)
if obj:
    num = int(obj.group(2))+25
    ln=obj.group(1) + str(num) + obj.group(3) + str(num) + obj.group(5) +'\n'
    fout.write(ln)
fin.close(); fout.close()
#
# for more info about regular expression syntax and KiCad component generation:
# http://gskinner.com/RegExr/
# http://kicad.rohrbacher.net/quicklib.php


	
While merging the two components into one, it is necessary to use the
    Library Editor from Eeschema to move the first component so that the second
    does not end up on top of it. Below you will find the final .lib file and
    its representation in Eeschema.



Contents of a *.lib file. 

EESchema-LIBRARY Version 2.3
#encoding utf-8
# COMP
DEF COMP U 0 40 Y Y 1 F N
F0 "U" -1800 -100 50 H V C CNN
F1 "COMP" -1800 100 50 H V C CNN
DRAW
S -2250 -800 -1350 800 0 0 0 N
S -450 -800 450 800 0 0 0 N
X PIN1 1 -2550 600 300 R 50 50 1 1 I

...

X PIN49 49 750 -500 300 L 50 50 1 1 I
ENDDRAW
ENDDEF
#End Library


[image: 10000000000004800000026769DAE0A4_png]
	
The Python script presented here is a very powerful tool for manipulating
    both pin numbers and pin labels. Mind, however, that all its power comes for
    the arcane and yet amazingly useful Regular Expression syntax:
    http://gskinner.com/RegExr/.




Chapitre 7. Make component footprints



Unlike other EDA software tools, which have one type of library that
contains both the schematic symbol and the footprint variations, KiCad
.lib files contain schematic symbols and .kicad_mod files contain
footprints. Cvpcb is used to successfully map footprints to symbols.
As for .lib files, .kicad_mod library files are text files that can
contain anything from one to several parts.
There is an extensive footprint library with KiCad, however on occasion you
might find that the footprint you need is not in the KiCad library.  Here
are the steps for creating a new PCB footprint in KiCad:

7.1. Utiliser l’Editeur d’Empreintes



	
Lancez Pcbnew depuis le gestionnaire de projet KiCad. Cliquez sur l’icône
    Ouvrir l'éditeur d’empreintes
    [image: edit_module_png] dans la barre d’outils
    du haut.

	
Nous allons enregistrer la nouvelle empreinte MYCONN3 dans la nouvelle
    librairie d’empreintes monempreinte. Créez un nouveau dossier
    monempreinte.pretty dans le repértoire de projet tutorial1/. Cliquez sur
    Préférences → Gestionnaire des Librairies d’empreintes et cliquez sur
    le bouton Ajouter Librairie. Dans le tableau, entrez "monempreinte" dans
    Pseudo nom, "${KIPRJMOD}/monempreinte.pretty" dans Chemin Librairie et
    "KiCad" dans Type de Plugin. Cliquez sur OK pour fermer la
    fenêtre. Cliquez sur l’icône Sélection de la librairie active
    [image: library_png] dans la barre d’outils du
    haut. Sélectionnez la librairie monempreinte.

	
Click on the New Footprint icon
    [image: new_footprint_png] on the top toolbar.
    Type MYCONN3 as the footprint name. In the middle of the screen the
    MYCONN3 label will appear. Under the label you can see the REF*
    label. Right click on MYCONN3 and move it above REF*. Right click on
    REF__*, select Edit Text and rename it to SMD. Set the Display value
    to Invisible.

	
Cliquez sur l’icône Ajouter pastilles [image: pad_png]
    sur la barre d’outils de droite. Cliquez sur la feuille de travail pour
    placer la pastille (pad). Faites un clic-droit sur la pastille et choisissez
    la commande Editer Pad. Vous pouvez également utiliser la touche de
    raccourci e.

[image: Pad Properties]

	
Définir le Numéro de pad à 1, la Forme à Rectangulaire, le Type de
    pad à CMS, la Taille X à 0.4 et la Taille Y à 0.8. Cliquez sur
    OK. Cliquez à nouveau sur Ajouter pads et placez deux pastilles
    supplémentaires.

	
Si vous souhaitez changer le pas de la grille : clic-droit → Sélection
    grille. Assurez-vous de sélectionner un pas de grille approprié au routage
    du composant.

	
Déplacez les étiquettes de manière à ce que l’empreinte ressemble à l’image
    ci-dessus.

	
Lors du placement des pastilles, il est souvent nécessaire de mesurer les
    distances relatives. Placer le curseur à l’endroit où vous souhaitez placer
    l’origine relative (0,0) et appuyez sur la barre d’espace. Vous voyez
    alors apparaître en bas de la page la position relative du curseur qui
    change lorsque vous le déplacez. Appuyez sur la barre d’espace à chaque fois
    que vous souhaitez définir une nouvelle origine.

	
Ajoutons maintenant le contour de l’empreinte. Cliquez sur l’icône Addition
    de lignes ou polygones graphiques
    [image: add_polygon_png] dans la barre d’outils
    de droite. Dessinez le contour du connecteur autour de l’empreinte.

	
Click on the Save Footprint in Active Library icon
    [image: save_library_png] on the top toolbar,
    using the default name MYCONN3.




Chapitre 8. Remarques sur la portabilité des fichiers d’un projet KiCad



What files do you need to send to someone so that they can fully load and
use your KiCad project?
When you have a KiCad project to share with somebody, it is important that
the schematic file .sch, the board file .kicad_pcb, the project file
.pro and the netlist file .net, are sent together with both the
schematic parts file .lib and the footprints file .kicad_mod. Only
this way will people have total freedom to modify the schematic and the
board.
With KiCad schematics, people need the .lib files that contain the
symbols. Those library files need to be loaded in the Eeschema
preferences. On the other hand, with boards (.kicad_pcb files),
footprints can be stored inside the .kicad_pcb file. You can send someone
a .kicad_pcb file and nothing else, and they would still be able to look
at and edit the board. However, when they want to load components from a
netlist, the footprint libraries (.kicad_mod files) need to be present
and loaded in the Pcbnew preferences just as for schematics. Also, it is
necessary to load the .kicad_mod files in the preferences of Pcbnew in
order for those footprints to show up in Cvpcb.
If someone sends you a .kicad_pcb file with footprints you would like to
use in another board, you can open the Footprint Editor, load a footprint
from the current board, and save or export it into another footprint
library. You can also export all the footprints from a .kicad_pcb file at
once via Pcbnew → File → Archive → Footprints → Create
footprint archive, which will create a new .kicad_mod file with all the
board’s footprints.
Bottom line, if the PCB is the only thing you want to distribute, then the
board file .kicad_pcb is enough. However, if you want to give people the
full ability to use and modify your schematic, its components and the PCB,
it is highly recommended that you zip and send the following project
directory:
tutorial1/
|-- tutorial1.pro
|-- tutorial1.sch
|-- tutorial1.kicad_pcb
|-- tutorial1.net
|-- library/
|   |-- myLib.lib
|   |-- myOwnLib.lib
|   \-- myQuickLib.lib
|
|-- myfootprint.pretty/
|   \-- MYCONN3.kicad_mod
|
\-- gerber/
    |-- ...
    \-- ...

Chapitre 9. Documentation complémentaire à propos de KiCad



Ce qui précède est une description rapide de la plupart des caractéristiques
de KiCad. Pour des explications plus détaillées, consultez les fichiers
d’aide auxquels vous pouvez accèder à partir de chaque module de
KiCad. Cliquez sur Aide → Documentation de (Eeschema par exemple).
KiCad est accompagné d’un jeu de manuels disponible dans plusieurs langues
pour ses 4 composantes logicielles.
Les versions anglaises de tous les manuels KiCad sont distribuées avec
KiCad.
En plus de ses manuels, KiCad est distribué avec ce tutoriel qui est traduit
dans d’autres langues. Toutes les versions de ce tutoriel sont distribuées
librement avec toutes la versions récentes de KiCad. Ce tutoriel ainsi que
les manuels devraient se trouver avec votre version de KiCad.
Par exemple, sous Linux, les emplacements typiques sont les répertoires
ci-dessous : (cela peut cependant dépendre de votre distribution)
/usr/share/doc/kicad/help/en/
/usr/local/share/doc/kicad/help/en
Sous Windows :
<installation directory>/share/doc/kicad/help/en
Sous OS X:
/Library/Application Support/kicad/help/en

9.1. La documentation de KiCad sur l’internet



Les dernières documentations de KiCad sont disponibles dans plusieurs
langues sur l’internet.
http://kicad-pcb.org/help/documentation/
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